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Welcome to Autodesk Revit 
Thank you for your interest in the Autodesk®

 Revit®
 building information modeler. We hope 

you enjoy using this powerful tool. We believe you will find Autodesk Revit easy to use, fast, 
and fun. This document provides details on the tools available to help you create great 
designs better and faster than ever before.  

About This Guide 
The Autodesk Revit 6 Preview Guide provides a quick overview of the product. The 
philosophy of designing in Autodesk Revit is stressed throughout the guide so that you can 
start to see how you may want to create your designs. Key advantages of the product are 
also stressed so that as you begin using Autodesk Revit you have a basic knowledge of the 
functionality and how to apply it. 

This document is not intended to be a user guide. Autodesk Revit has a complete help 
system that includes context-sensitive help. For specific product questions, please refer to 
the online help. 

We encourage you to complete the training that is available for Autodesk Revit users. A 
complete set of self-paced training tutorials is available in the Autodesk Revit program or 
referenced from the Training section of the Revit Product web page at 
www.autodesk.com/revit. Or you can attend live, web-based training classes from the 
comfort of your own desk. For a schedule of classes, visit the Training section of the 
Autodesk Revit website at www.autodesk.com/revit-training. 

Autodesk Revit Terms 
Most of the terms used to identify objects in Autodesk Revit are common, industry-standard 
terms familiar to most architects. This section defines the basic terms used in Autodesk 
Revit. 

The first term you need to know is project. In Autodesk Revit, the project is the single 
database of information for your design—the building information model. The project file 
contains all the information for your building design, from geometry to construction data. 
This information includes components used to design the model, views of the project, and 
drawings of the design. By using a single project file, Autodesk Revit makes it easy for you 
to alter your design and have changes reflected in all associated areas (plan views, 
elevation views, section views, schedules, and so forth). Having only one file to track also 
makes it easier to manage the project. 

When creating your project, you add Autodesk Revit parametric building elements to the 
design. All elements are considered categories. Autodesk Revit classifies elements by model 
component elements and annotation elements. A model component element, such as a 
door, desk, or roof, represents the actual 3D geometry of the building. An annotation 
building element, such as a door tag, elevation symbol, or room tag, helps document the 
model.  

Families are classes of elements in a category which group elements with a common set of 
parameters (properties), identical use, and similar graphical representation. Different 
elements in a family may have different values for some or all properties, but the set of 
properties—their names and meaning—is the same. For example, six-panel colonial doors 
could be considered one family, although the doors that compose the family come in 
different sizes and materials. Most families are component family files, which means you 
can load them into your project and create them from family templates. You can determine 
the set of properties and the graphical representation of the family. Other families are called 
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system families. These families, which include walls, dimensions, ceilings, roofs, floors, and 
levels, are not available for loading or creating as separate files. Autodesk Revit predefines 
the set of properties and the graphical representation of system families. You can use the 
predefined types to generate new types that belong to this family within the project. For 
example, the behavior of a wall is predefined in the system; however, you can create 
different types of walls with different compositions. These new types can be transferred 
between projects. 

Each family can have different types. A type can be a specific size of a family, such as a 30 
X 42 title block or a 1730 X 2032 door. A type can also be a style, such as default linear or 
default angular style for dimensions. A family can have several types. For example, a table 
could come in several different sizes. Each different size would be a new type within the 
same family. 

Instances are the actual items that are placed in the project and have specific locations in 
the building (model instances) or on a drawing sheet (annotation instances).  

What’s New for 6.0 
There are several new features in Revit to improve your workflow and help you design your 
project. 

Multi-user Element Borrowing 
This allows you to borrow elements from worksets you do not own. It saves time and keeps 
workflow in tact. 

Design Options 
You can use design options to create alternate schemes inside a single project. One option 
can be a primary option, which is the preferred option, and you can have several others as 
secondary options.  

Baluster Patterns 
You can design railings with complex baluster patterns. You can create baluster patterns 
through the type properties of the railing. 

Stair Improvements 
You can create more stair conditions using new type properties for stairs. Among the 
improvements are monolithic stairs.  

Ellipses 
You can create full or partial ellipses in Revit. They can be drawn as model or detail lines 
and used in sketches. Ellipses are available both in projects and the Family Editor.  

Plan Region 
You can define a region with a plan view and then set that region to have a different view 
range from the rest of the plan view.  

Project Browser Customization 
You can organize the view structure in the Project Browser in a manner that best suits your 
needs. You can group views and sheets in the Project Browser and exclude certain views 
using a view property as a filter.  

Spell Checker 
Revit now offers a spell checker that spell checks text notes in views and on sheets.  



 Autodesk Revit 6 Preview Guide 

 www.autodesk.com/revit 5 

Detail Views 
Revit can create common architectural detail views: building section, wall section, and detail 
views. Detail views can be either callouts or sections.  

Schedule Formulas and Filtering 
Schedules can have formulas that will calculate values in fields. You can also filter a 
schedule using fields. For example, you might have a window schedule and only want to 
show those windows on level 2. You can filter the windows by their level.  

Repeating Details 
This tool makes detailing easier in plans and sections. You can lay out objects like metal 
deck, brick, and CMU simply by sketching lines. As you sketch, Revit draws the appropriate 
detail component based on layout rules you define.  

The User Interface 
One of the advantages of Autodesk Revit is its ease of use, specifically its clear user 
interface. The Autodesk Revit window is arranged to make navigation easy. Even the toolbar 
buttons are labeled, making it easy to understand what each button represents.  

Autodesk Revit uses standard Microsoft® Windows® conventions. If you have used any other 
product that follows these conventions, learning Autodesk Revit is much easier. The menu 
bar across the top of the window includes standard menu names such as File, Edit, and 
View. You probably already know that you can create new files from the File menu and that 
you can cut, copy, and paste from the Edit menu. Using these standards accelerates 
learning so you can start designing immediately. 

 

 

Figure 1. The Autodesk Revit window  
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The Autodesk Revit user interface can be divided into several key areas. Across the top of 
the window is the standard menu bar. This menu bar contains the Autodesk Revit 
commands that you use to create your project. You can choose commands by placing the 
cursor over the menu name and clicking. Then click the command name to run the 
command. Many of the commands also have accelerator keys to speed up the design 
process. These accelerator keys are listed next to the command on the menu. Simply type 
the required keystrokes to run the command. 

Another timesaving tool for selecting commands is to place the cursor in the document 
window and right-click. A shortcut menu appears with a list of all available commands. The 
shortcut menu changes depending on the function you are performing and what is currently 
selected. It is another tool in Autodesk Revit that enables you to work more efficiently. 

Across the top of the window is a toolbar. The buttons on the toolbar represent some of the 
more common Autodesk Revit commands. Below the toolbar is the Options toolbar. The 
buttons on this toolbar change, depending on the current command.  

 

Figure 2. Autodesk Revit toolbars. 

Design Bar 
The design bar is located on the left side of the Autodesk Revit interface. There are 10 
panes in the design bar, containing buttons grouped by function.  

• Basics pane—includes commands for creating a basic building  

• View pane—includes commands for creating different views in the project  

• Modeling pane—includes all the commands to create model elements  

• Drafting pane—includes commands for both adding annotation symbols and creating the 
sheet details for the project construction documents  

• Rendering pane—includes commands for creating rendered 3D images  

• Site pane—includes commands for producing site plans  

• Massing pane—includes commands for executing conceptual massing commands  

• Area Analysis pane—includes commands for making area schemes  

• Structural pane—includes commands for adding structural components to your project  

• Construction pane—includes commands for creating construction industry information  

To access each of the panes, simply click the tab of the pane and the design bar displays 
the appropriate commands.  

Dialog Boxes 
Dialog boxes are used throughout Autodesk Revit to help you easily add and change 
different properties of objects. Dialog boxes offer an efficient method for making 
modifications or for adding information to your Autodesk Revit project. 

The dialog box in the following figure is used for setting the properties of materials.  

Toolbar 
Options toolbar 
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Figure 3. Use the Materials dialog box to set properties for materials. 

Project Browser 
You can use the project browser to quickly manage the views, families, and groups of your 
current project. The browser is on the left side of the interface (see Figure 1). In the 
browser you can add, delete, and rename views, families, and groups. The browser is 
conveniently organized by view type (floor plans, elevations, 3D), family category (doors, 
walls, windows), and group name. You can expand or compress the browser list by clicking 
the + or − sign next to the name. To open a view, double-click the name. You can also drag 
and drop from the browser, making it easy to add a family or group to the project or add a 
view to a sheet. The browser is also dockable, so you can position it wherever you want. 

Autodesk Revit Help 
Help is available online at all times during an Autodesk Revit session. To access help, click 
the Autodesk Revit Help command on the Help menu. You can use this tri-pane, HTML help 
window to search for information and quickly display it to read or print. There are several 
tools that help you find information. You can select a topic on the Contents tab, find a 
keyword on the Index tab, search for all instances of a word or phrase on the Search tab, or 
save commonly used pages on the Favorites tab.  
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Figure 4. Use Autodesk Revit online help to search for product information.   

Context-sensitive help is also available to provide instant help on any menu command. 

Click to access context-sensitive help. Clicking this button places a question mark on the 
cursor . Simply move the cursor over the command and click to open context-sensitive 
help. Help for dialog boxes is available by clicking the Help button in the dialog box.  

There is also easy-to-follow, online training to help you learn the software. These self-paced 
training tutorials are designed to get you up to speed quickly. All the files for the exercises 
are provided on the Autodesk Revit CD or from the Training section of the Autodesk Revit 
product web page at www.autodesk.com/revit. You can access the training exercises in the 
product from the Tutorials command on the Help menu.  

For more in-depth instruction, you can attend Autodesk Revit Distance Learning Seminars 
from the convenience of your desk. These live seminars are designed to help you learn 
about the power of Autodesk Revit from an expert. A complete schedule is available on the 
Training section of the Autodesk Revit product page at www.autodesk.com/revit. To attend, 
all you need is a web browser, an Internet connection, and a phone. 

The Autodesk Revit Project 
As you build your Autodesk Revit project you are creating a 3D representation of the 
building. This building information model is like a spreadsheet that can easily be accessed. 
All information in the model is shared within the different views of the model, which update 
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instantaneously as the model is changed. These views can be graphical (floor plans, 
elevations, and so forth) or informational (schedules).  

Autodesk Revit Views 

As you create a project, Autodesk Revit automatically sets up certain common views, such 
as floor plans and elevations that you need in order to document your building project. No 
setup is required, although you can create your own custom templates so that your 
standards are automatically added to each new project. As you add new levels to the 
project, the appropriate floor plan and reflected ceiling plan views are created automatically. 
You can display these views at any time by selecting them from the project browser, and 
they are completely associated with the project. If you modify an element in one view it 
automatically updates in any other view in which it is displayed. You can also add these 
views to sheets to help create your document set. 

You can also create your own views, such as 3D views, section views, interior elevation 
views, callout views, schedules, and photorealistic renderings. You can create a new view by 
clicking the New command on the View menu or by clicking the command in the View 
design bar.  

You can create a 3D view and orient it to any viewpoint by using the 3D command to create 
the view and then rotate the building (using the DynView command) to the desired 
orientation. You can create as many 3D views as you want. You can quickly create 3D 
perspective views using the Camera command and selecting a viewing point and a view 
direction. 

Figure 5. Create any number of 3D views to help visualize your project. 

You can create a section view of your model by simply sketching the cutting plane line in 
plan view. Autodesk Revit automatically creates the section view and the cutting plane line 
with the section head symbol attached. You can view the section by simply double-clicking 
the section view symbol or by selecting it from the project browser. You can even move the 
section by simply dragging the selection line to a new location. When you add the section 
view to a sheet, the sheet information is automatically added to the section head. 

3D View of Fire Station

3D Camera Perspective View of Fire Station
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Figure 6. Create a section view by sketching the cutting plane line. 

You can create interior elevation views by placing a view direction symbol in the room. You 
can create all four interior elevations from this one symbol. The elevation extends to the 
boundary of the room. You can then control the extents of the elevation by dynamically 
dragging the clip plane in the view to include what you want to see. 

You can easily create callout views by specifying a callout box around the area of detail. 
Autodesk Revit automatically includes everything within the box in the callout view. You can 
then add this view to any sheet for detailing. 

You can create many different schedule types for Autodesk Revit modeling components such 
as doors and windows. The schedule information is extracted from the properties of the 
components. The customizable schedules can include any of the standard system-supplied 
properties or up to 24 user-defined properties. These schedule views can then be added to 
drawing sheets or exported using a delimited text format to a spreadsheet program. The 
schedules are also associated with the building information model. If any change in the 
building affects the schedule, it instantly updates. In fact, you can change information in the 
schedule, and your building model updates accordingly. 

Figure 7. Autodesk Revit automatically extracts schedule information from the properties of the 
components.  

Floor Plan with Cutting Plane Line

Section View
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You can create photo-realistic renderings of your buildings in Autodesk Revit using 
AccuRender® software integrated into Revit. This creates a rendered image of your design 
using the material textures assigned to the different categories of the Autodesk Revit 
elements. You can also export your model to use Autodesk® VIZ software for more 
advanced visualization. 

 

Figure 8. Create photorealistic renderings in Autodesk Revit using AccuRender software. 

Creating Drawings 
The drawings of your building are created as part of your project file. The views that you 
created in the project are used to create the drawing views. They are added to standard-
size drawing sheets with borders and title blocks. You can use the supplied Autodesk Revit 
title blocks or easily create your own.  

To add to the sheet, you simply select the views from the list of views and schedules in the 
project, and place them on the sheet. The view scale is determined by the scale in the View 
Properties. You can easily change the view scale by selecting from a list of standard scales 
or by entering a custom scale. 

You can create details of your design directly from your design. You can use various detail 
tools to sketch and place detail elements. These details can also be associated to the 
building model so if a change is made to the model, the detail automatically updates. You 
can also import any existing details using DXF™, DWG, or DGN® files. 

You can work on the building in the drawing view by activating the view. When the view is 
active, you can add or delete elements, change the view display, and modify the placement 
and size of components. With Autodesk Revit, you don’t need to constantly toggle between 
the model and the drawing. And because of the associativity between views, any changes 
are automatically reflected throughout the project. 

Manipulating the View Display 
Each of the views in your project has display settings that you can use to help visualize your 
project. There are four display settings: wireframe, hidden line, shading, and shading with 
edges. The display setting is view specific, so you can have different views of your building 
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with different display settings. The following figure compares the difference among the 
settings. 

Figure 9. Use four different display settings to visualize your project. 

You can also use the Visibility command to specify which categories and subcategories to 
display. This is useful when working with a large building. With the Visibility command, you 
can turn off certain elements to simplify your building display. Notice in the next figure the 
roof display has been turned off so you can easily see the inside of the building. 

Figure 10. Simplify your building display by turning off elements, such as the roof display. 

Autodesk Revit has many commands you can use to zoom, pan, and spin your model so 
that you can quickly change view size and orientation. The commands are on the toolbar, 
shortcut menu, and View menu. If you have a mouse with a wheel, you can use it to quickly 
perform dynamic panning, zooming, and spinning. To zoom in or out, simply scroll using the 
wheel. To pan, hold the wheel down and move the cursor. To spin, hold SHIFT and the wheel 
while moving the cursor.  
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Using the Walkthrough command, you can define a path and create an animated or 
rendered walkthrough in any of the display modes. 

Importing and Exporting Information 
To take advantage of existing data, you may want to exchange information between 
Autodesk Revit and other software packages. Autodesk Revit supports 2D and 3D DXF and 
DWG formats and MicroStation® DGN format.  

In some instances you may import 2D geometry, such as a site layout, and use this 
information to create your Autodesk Revit model. You could then link your project to the 2D 
file that you imported and if it ever changes, you will see the change in your model.  

You may also want to export your model. You can export view sheets or entire drawing 
sheets in any of the supported formats and open these files in the appropriate software. For 
example, you might want to send your Autodesk Revit project to a subcontractor who does 
not use Autodesk Revit.  

Exporting to ODBC 
Autodesk Revit can export ODBC-compliant data. After you have chosen a data source, 
Autodesk Revit populates database tables with data from the current project. Autodesk 
Revit creates one database table listing all instances and another listing all types of model 
elements in the project. Additional tables are created for levels and rooms, listing instances 
only, and for assembly codes, listing each uniformat assembly code in the project. 

Creating the Building Information Model 
Autodesk Revit provides the tools to quickly create and modify your building design, 
capturing your design intent as you build. This flexibility gives you the freedom to try 
different designs without having to start over if it is not right the first time. 

Autodesk Revit provides a library of elements for use in your project. The elements can be 
broken into two groups: modeling component elements (used to create the physical 
geometry of the building) and annotation elements (used to document the design).  

In addition to the standard library, you can also create your own parametric families of 
elements by either modifying an existing element or by using the Family Editor. When 
designing your own families, you do not have to be a programmer to create an intelligent 
element. Autodesk Revit provides a template for the family that contains all the intelligence 
of that element. You simply add the geometry and properties you want.  

Adding Components to Your Model 
There are two different methods you can use to add components to the project. The first 
method is the pick-and-drop method. This method is used for standard objects in which the 
size and shape of the element is set by the element type. With this method, you simply 
select the type of element you want, move the cursor to the location you want, and drop it 
in place. The element appears on your cursor as you drag it, so you can easily see how it 
fits in the design. In fact, for insertable elements, such as windows and doors, the system 
automatically checks to see whether the element fits. If it will not fit, the element 
disappears from your cursor as you drag it. 

The second method is the sketching method. This method is used for components that are 
not of a predetermined size, such as walls, floors, and roofs. These components require that 
you specify the profile or footprint of the element by sketching it. Autodesk Revit provides 
tools to help make sketching the profiles as easy as possible. For example, to place a 
ceiling, you simply select the room in which you want to place the ceiling, and the system 
automatically draws the ceiling to the extents of the room.  
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Later in this document we discuss some of the common elements that you use to create 
your project, but first you should know a few of the tools that are used to make your project 
creation quick and easy. 

Sketching in Autodesk Revit 
Sketching is used in component creation to define a profile for the element, add walls to the 
project, and create drawing details. There are many tools for you to use to sketch the 
desired shape. 

As you sketch lines or walls in Autodesk Revit a temporary dimension appears from the last 
sketched point to the cursor. You can use this dimension as a guide when you sketch. For 
example, if you want a wall 10 feet in length, simply drag the cursor until the dimension is 
10. Click to place the point. There is no need to enter exact dimensions. In Autodesk Revit 
you can drag the sketch and place the point where you want. Immediately after sketching 
you can modify the temporary dimensions. Or, if you want, as you are sketching a line, you 
can type a value to immediately snap to that linear distance. 

To further guide you in sketching, Autodesk Revit provides automatic alignments while you 
work. This makes it easy to reference existing lines or walls when sketching. To signify an 
alignment, a green dashed line appears from the alignment entity to your cursor as you are 
sketching. This makes the alignment immediately apparent.  

Figure 11. A green dashed line indicates an alignment. 

Dimensioning in Autodesk Revit 
Of course, you need a fully dimensioned project, and once again Autodesk Revit provides 
the tools to make your job as easy as possible. In Autodesk Revit, there are two kinds of 
dimensions: temporary and permanent. Autodesk Revit automatically creates temporary 
dimensions as you sketch or place elements. When sketching, the system creates these 
dimensions along the sketched line or wall. When you place an element, the system creates 
the temporary dimension from the nearest perpendicular reference to the element being 
placed. This makes it easy to quickly place a component where you want it. You can then 
modify it to whatever distance you want. If you do not like the temporary dimension 
Autodesk Revit creates, you can change the origin of the dimension to wherever you want. 

You create permanent dimensions to capture your design intent. For example, in the next 
figure, notice that the system created two temporary dimensions from the nearest wall. 
These dimensions were perfect for locating the window an equal distance from the two 
walls. However, if you really wanted your dimension to come from the end of the building, 
all you need to do is add the permanent dimension as shown. 
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Figure 12. Autodesk Revit includes permanent and temporary dimensions. 

Locking Dimensions and Alignments  
Locks are provided to help you capture your design intent. Locks appear on permanent 
dimensions, on anything aligned, and on elements. 

When a lock is set to Unlocked, the element is free to move; however, if you change the 
status to Locked, the dimension, placement, or alignment cannot be changed. If you lock a 
dimension, that dimensional value cannot be changed without first removing the lock 
constraint. Also, if either of the components being dimensioned is moved, the other 
component moves accordingly. Alignment locks work the same way. If you lock two walls or 
sketched entities that are aligned, as one of the entities moves the aligned entity moves 
with it. 

Figure 13. Dimension and alignment locks help you capture your design intent. 

Starting Your Project 
To start your project you can click  or choose File, New, Project. Choose Open from the 
dialog box to start the project. When you create the project, Autodesk Revit automatically 

applies the template that you have chosen (if you use , it applies the default template) 
and creates several elements for you. First, Autodesk Revit creates several views for you: 
all four elevation views (North, South, East, and West), a floor plan view for each level in 
your project (Floor Plan: Level 1 and Floor Plan: Level 2), and a reflected ceiling plan for 
each level in your project (Reflected Ceiling Plan: Level 1 and Reflected Ceiling Plan: Level 
2).  

If you use the default template, Autodesk Revit creates two levels: Level 1 and Level 2. You 
can add other levels at any time during the design of your project. Every time you add a 
level, Autodesk Revit creates a floor plan view and a reflected ceiling plan view for your 
project.  

Permanent Dimension Temporary
Dimension

Alignment Lock

Dimension Lock
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There are many different ways to design your building, and Autodesk Revit gives you the 
flexibility to choose how you want to design. It does not force you to design in a certain 
way. 

Before adding building components to the project, you may want to set up certain known 
building parameters, such as levels, lines, and column grids.  

To add levels to your project, open an elevation view (double-click the view name in the 
browser window) and click Level on the design bar. Click at the start location of the level, 
drag the cursor horizontally, and click to place the level. You can modify the height and 
name of the level by clicking the appropriate text and changing it however you want.  

Figure 14. Adding Levels 

Autodesk Revit gives you the flexibility to sketch or import drawing geometry to help define 
the placement of building geometry or to represent existing structures that need to be 
referenced in the project. Using the Lines command, you can conceptualize the layout of 
your walls in 2D. Once the conceptual layout is started, you can use the lines to place the 
wall components. In the following figure an existing site layout was imported and is used to 
sketch wall locations. 

Figure 15. An existing site layout can be used to sketch wall locations. 

You may also want to start your project by creating a column grid. You can do this by 
sketching the grid using the Grid command. You can create your own grid in plan view and 
then use this grid to snap columns when placing them. 

2D Sketch

Wall Component
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Figure 16. Column Grid 

Autodesk Revit also provides tools that help you start your design by creating conceptual 
massing geometry. Using these geometry creation tools, you can quickly add geometry to 
your design. You can then transform the conceptual mass into walls, floors, and roofs, 
automatically. This design is associated to the massing, so if you ever go back and change 
the massing, the entire project updates accordingly. 

 

 
Figure 17. An Autodesk Revit massing design 

Project Sharing  
Autodesk Revit worksets enable multiple users to work on a single project. Each workset 
can be created and assigned to a specific functional area, such as exterior or interior work. 
A team member checks out a workset and works independently in that workset. When work 
is complete, that team member checks changes into a master project file, which also 
includes changes from other team members.  

File Linking 
Autodesk Revit enables you to combine building models within your project. You can link 
multiple buildings together for a multi-structure project such as a campus. By linking files, 
you can create much larger projects and have larger project teams. 
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Figure 18. Use file linking to create multistructure projects.  

Using Components to Build Your Design 
Parametric building components are elements that are used to add geometry to your 
project. Autodesk Revit provides numerous families of components that you can use to start 
creating your building immediately. A Family Editor tool enables you to easily create your 
own families. The modeling components can be accessed from the Modeling menu or from 
the Modeling design bar on the left side of the window. 

To help you get started in your project creation, the next sections cover some of the more 
commonly used components: walls, windows, doors, floors, ceilings, roofs, and stairs. The 
procedures used to create these components can be applied to other Autodesk Revit 
components as well.  

Creating Walls 
Walls are created by sketching the outline of the wall. You can sketch using the wall 
centerline, outside face, inside face, outside core, centerline of core, or inside core. As you 
sketch, temporary dimensions and snap lines help you sketch the desired shape. If you 
started with a 2D sketch, you can snap to this grid while sketching the walls. The type of 
wall is specified in the Type Selector, located in the upper left corner of the Autodesk Revit 
interface. 

Figure 19. Use the Type Selector to specify the type of wall. 

Walls are sketched in a floor plan or 3D view. At any point while adding walls, you can open 
another view to see how the design appears from other orientations. The Tile command on 
the Window menu is useful to display several views at the same time, so you can actually 
see your design as it is built. 
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Figure 20. The Tile command displays several views of your design at the same time. 

Use the Chain command to quickly create connected walls and lines by clicking each end 
point. Use the other sketching commands on the Options toolbar to create three-point arcs, 
center or endpoint arcs, tangent arcs, circles, splines, ellipses, and fillets. You can use 
Autodesk Revit sketching features to sketch the outline of the wall without having to enter 
exact distances. Use the temporary dimension that appears as a guide to achieve the size of 
the wall you want. By default, the dimensions snap to 6” increments. You can set the snap 
size to any increment using the Snaps command on the Settings menu. 

Compound Walls 
You can define walls of multiple compositions. With this wall type, you can define the total 
wall thickness as well as the material and thickness of the wall layers. As you can see in the 
next figure, this wall has had several layers of material defined for the wall structure. 
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Figure 21. Compound walls can consist of several layers of material.  

You can also create walls that are vertically compound walls. In the next figure you can see 
that the wall has different materials as it changes height. Also there are reveals and a wall 
cap at the top of the wall. These are all defined in the structure of the wall. 

Figure 22. A compound wall can include different materials, reveals, and a wall cap. 

Curtain Walls 
Curtain walls are a special wall type. The wall outline is created in the same way as other 
walls. The difference is that with curtain walls, you must have a grid to divide the wall into 
horizontal and vertical panels. The system adds panels to each grid section. You can create 
your own panels and add them to the wall in any combination. The software automatically 
resizes the panel to fit in the grid section. That means you have to create only one size 
panel for each type of panel you need and the system sizes it for you.  
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Figure 23.  

Modifying Walls 
As your project develops, your design may change. Many of these changes require you to 
modify walls. Autodesk Revit provides several tools to help you in this process. The easiest 
modification method is to move a wall. To modify a wall, simply click the Modify command 
and select the wall. To move the end of the wall, drag the blue control that appears at the 
end. To move the entire wall, select it and drag to wherever you want.  

Figure 24. To move a wall, simply select it and drag to a new location. 

You can modify a temporary or permanent wall dimension by selecting the wall using the 
Modify tool. This makes the dimension editable. Click the dimension value and type a new 
value. The wall then moves accordingly. 

You can also modify the profile of a wall. This is useful in modifying the outside elevation 
profiles of the wall. Click Modify and select the wall. Click Edit Elevation Profile on the 
Options toolbar and change the profile sketch of the wall to include your desired 
modification. 

Original location

Modified Location



 Autodesk Revit 6 Preview Guide 

 www.autodesk.com/revit 22 

Figure 25. Use the Edit Elevation Profile command to change the wall’s profile sketch.  

Walls have user-definable properties that determine the appearance of the wall in the 
project. You can change these properties at any time. To access these properties, click 
Modify and select all the walls of the same type you want to modify. Click Properties. The 
instance parameters section of the dialog box lists all the properties that can be modified.  

The wall properties enable you to specify the height of the top and bottom of the wall. You 
can use these property values to capture your design intent for the wall. For example, in a 
three-story building, you may set the height of the exterior walls to extend to Level 3 by 
choosing Up to level: Level 3 in the Top Constraint property. For interior walls you may set 
the value so the height of the wall extends to the next level.  

You can also split a wall horizontally or vertically using the Split Walls and Lines command. 
This tool enables you to have two different wall types side by side or one on top of the 
other. 

Windows and Doors 
Doors and windows are insertable components. To add the component you simply select the 
component type and drop it in the correct position in a wall. The family type already has the 
size, shape, and positioning information. For example, when you select the door and drag it 
to a wall to place it, the door type determines the size of the door. The door is placed at the 
floor level and cuts the opening in the wall automatically.  

As you move doors and windows into position, they automatically snap into a wall. You can 
place doors and windows in many different view types, such as floor plan views, elevation 
views, and 3D views. This makes it easy to visualize how the component will appear in the 
building. As you drag the component it appears on the cursor. Temporary dimensions also 
appear to help you place the component exactly where you want. If you drag the 
component to an area in which it cannot be placed, the component disappears from the 
cursor, indicating that it won’t fit in that area. 

Figure 26.  Adding windows and doors 

Autodesk Revit comes with predefined door and window types. Or you can create your own 
family types using the Family Editor (see “Creating Your Own Component Families” later in 
this document) or by simply modifying some of the predefined dimensions and creating a 
new family type. Autodesk Revit provides the door and window family template with 

Edited wall profile
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predefined standard dimensions and subcategories. To define the family, you simply add the 
geometry and any dimensional information you require. This is all done through the simple 
graphical user interface and not through a complex programming language. 

Floors and Ceilings 
You add floors and ceilings to the project by specifying a profile sketch of the component in 
a floor plan or reflected ceiling plan view. You can create the sketches by sketching the 
profile, using the Pick command to pick existing wall faces, or selecting a room and having 
the system automatically create the component (ceilings only). The sketches that reference 
the walls of your project can automatically be offset from the walls by a specified distance 
and update if the walls are moved. You can define compound floors and walls by specifying 
the structure of the component. 

When creating floors and ceilings, you can add openings for items such as stairs by 
sketching the opening within the profile. In fact, you could have several openings in the 
profile as long as they are closed loops and do not intersect other loops. 

You can also create families of floor and ceiling components that automatically attach and 
cut an opening when they are added. For example, you could create a recessed light fixture 
that creates the cutout in the ceiling as soon as it is added. You can also add sloped floors. 

Figure 27. Sloped floors automatically cut an opening when added.  

Roofs 

Figure 28. Multiple roof types 

You can use two methods to create complex, multilevel roofs in your project. The first 
method is the extrusion method. Simply sketch the profile of the roof from an elevation 
view and extrude it to the desired length.  
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Figure 29.  An Extruded Roof 

The other roof creation method is the footprint method. In this method you sketch the 
footprint of the roof in a plan view at the level you would like the roof to start. You then 
specify which of the lines of the sketch define the slope of the roof and the angle of the 
slope. To make it easy to identify the slope-defining line segments, Autodesk Revit places a 
symbol on the segment.  

Figure 30. The slope-defining line segment determines the slope of the roof. 

Slope Defining Line
Symbol
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Notice the change to the roof shape when all four lines in the preceding figure are set to 
slope defining. 

Figure 31.  

Using the Cutoff Level and Cutoff Offset properties, you can split a roof at a level or offset 
from a level and create another roof on top of it to achieve a tiered effect. 

Figure 32. Use Cutoff Level and Cutoff Offset properties to achieve a tiered effect. 

Autodesk Revit can also create sloped glazings in your building. 

Figure 33. Get a sloped glazing effect for your project. 

Stairs 
You can add stairs to your design at any time. They are created in a floor plan view, 
typically from the starting level of the stairs. One method of creating stairs is to define the 
centerline run of the stairs. As you start to create the run, the system displays a box 
indicating the footprint of the run of stairs. The system calculates the number of risers by 
using the height between the start and the end levels and the maximum riser height as 
defined by the stair family type properties. You do not have to calculate anything because 
the system does all the work. If you want a straight run of stairs, move your cursor outside 
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the box indicating the footprint of the stairs, orient the box to the direction you want, and 
click to place the stairs. When you finish the stair creation, the system automatically creates 
the stairs and adds the stringers, treads, risers, and rails. You can modify the stairs by 
modifying the stair properties. In this release more stair properties are added to allow 
design of more stair conditions.  

Figure 34. Adding a run of stairs. 

To make a jog in your stair run, create the first section of the run by defining a start and 
endpoint and then define the next section of run by defining a start and endpoint. After each 
section of run you create, the system displays how many risers have been created and how 
many risers remain. The system automatically creates a landing at each of the jogs in the 
run. Once again, you do not have to calculate anything. Just define the shape you want and 
let the system do the rest of the work. 

Figure 35. Simply define the shape you want to create a stair jog. 

If you want, you can create the stair geometry by defining the riser and boundary curves. 
This enables you to customize the stair shape to accommodate stairs that are not a 
standard rectangular shape with constant width.  
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Figure 36. Customize stair shape by defining riser and boundary curves. 

Railings are added to stairs automatically, but you may want to add them as separate 
components if you want a railing on a level, such as around a landing. 

Figure 37. Add railings as separate components for a landing. 

Rooms 
The Room Tag command is used to identify individual rooms in your design. To do this place 
a room tag in an enclosed space. To place a room tag, click the Room Tag command, place 
your cursor in an enclosed space, and click. The system places the room tag, adds the room 
properties, and automatically calculates the square footage of the room using the centerline 
of the walls that define the room. If the room size is ever modified, the system instantly 
updates the area in the properties.  
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Figure 38. Adding information to a room tag.  

Area Analysis Tools  
Area analysis tools include area schemes, plans, and boundaries. Multiple measurement 
schemes enable you to create a range of area reports. For example, you can define rentable 
areas and gross building area schemes.  

Structural Elements  
You can add structural beams, columns, and walls to your project. 

You can add beams and attach them to any other structural element in your project. 
Structural beams snap and attach to other structural elements, including structural walls. 
The beams also join to structural bearing walls where the structural usage parameter is set 
to bearing or structural combined. 

You can create structural columns that attach to other structural elements. You add 
structural columns in plan view. The height of the column is defined in the properties of the 
component, where you can define the Base Level and the Top Level as well as their offsets. 

You can add structural walls to your project. Structural walls are a category of building 
components and differ from nonstructural walls only in their structural usage. When adding 
a structural wall, Autodesk Revit sets the Structural Usage property to Bearing. You can 
change this attribute at any time by editing the wall properties. 

Creating a Site 
Autodesk Revit provides several tools for creating site plans: TopoSurface, Graded Region, 
Property Line, Pad, Parking Component, and Components.  

You can use the site tools to  

• Understand how building placement affects grading  

• Understand site setback relationships 



 Autodesk Revit 6 Preview Guide 

 www.autodesk.com/revit 29 

• Understand relationship of landscape to the building 

• Sketch organic site features and walkways  

• Eliminate time counting and documenting parking  

• Enter property line data using surveyor’s units (bearing distance) 

• Sketch centerlines and curb lines in plans 

• Place and schedule parking stalls  

Site tools help you communicate realistic site conditions in documents.  

Using Elements to Annotate Your Design 
As your project is being built, you may want to add Annotation Symbols to help document 
the design. You can add annotation symbols to your project at any point in the design 
process. 

Room Color 
You can use Room Color command to create color-filled views of the room. These properties 
include information such as room name, room number, occupant, department, and room 
finishes. You can give values to as many of the properties as you want. Once the properties 
have been set, you can use this information to generate the room color display. This 
component automatically generates a color-coded display of the rooms in a floor plan view. 
This color code is based on property values of the rooms. In the following room color 
scheme, the rooms are color-coded by department. The system automatically assigns 
colors, but you can modify them to any color you choose. You can also substitute any line 
fill patterns you may have in Autodesk Revit. Notice the system-generated legend in the 
lower left corner of the figure. 

Figure 40. Use the Room Color command to create color-filled views.  
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Dimensions 
Dimensions are annotation symbols. You can create linear, angular, and radial dimensions, 
and use these dimensions to modify the building geometry. Dimensions can be created in 
floor plan, elevation, reflected ceiling plan, section, and interior elevation views. To create a 
dimension, choose the Dimension command, select the entities to dimension, and then click 
to place the dimension text. When creating linear dimensions, you can select several items 
at one time to chain dimension entities.  

Figure 41. Setting equal spaced dimensions. 

Levels 
Levels are horizontal data marked in elevation views. They represent known height 
elevations, such as floor levels. They are displayed in elevation views as a horizontal 
centerline with a level tag on one end and can be created at any time during building 
design. The level name and height are displayed next to the level tag. When the level is 
created, a floor plan and reflected ceiling plan view can be automatically created. Any 
component that is created relative to the level moves accordingly if the level height is 
modified. 

Figure 42. Autodesk Revit level tags.  

Grid 
You can use the grid annotation symbol to create the column grid and to locate columns. It 
can be created in a floor plan, reflected ceiling plan, or elevation view. The columns snap to 
the grid and grid intersections, making it easy to place them after you have set up the 
column grid. 

EQ symbol to indicate
all dimensions in the
chain are equal.
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Reference Plane 
Use the reference plane element to create lines to aid in the creation of the building. The 
reference plane appears as a dashed line. The reference plane can be created in floor plan, 
reflected ceiling plan, or elevation views. Once you have placed the reference planes, you 
can place modeling components by snapping to the planes and their intersections. 

Text and Symbols 
You can add text to the sheet to annotate the different views. You can specify different fonts 
and sizes for the text. You can create symbols in the Family Editor as any type you want. 

Creating Your Own Component Families 
One of the many advantages of using Autodesk Revit is the ability to create your own 
families of components without having to learn a complex programming language. The 
entire family creation process is done within predefined templates that contain the 
intelligent objects needed to create the particular family type. You simply provide the 
information necessary to uniquely describe the family geometry.  

 
Figure 43. Window family template exterior elevation view. 

When defining a family, you define how the component appears in different views. For 
example, a door in a floor plan view may appear as a 2D symbol of a line with an arc 
representing the door swing. However, in the elevation and 3D views, you may want to see 
the 3D geometry of the door and doorframe. You create this geometry as you would want it 
to be displayed in your building. In many cases, you may not even need 3D geometry; 2D 
profiles may be sufficient. If this is the case, then you can quickly create the family using 
only the 2D profiles and achieve the desired effect. Ultimately, you determine how your 
family appears and you can quickly create it to achieve the results you want. 

For many families you may want to have many different types, each representing different 
sizes, with the same configuration of geometry. You can achieve this by labeling the 
dimensions that vary between the different family types. Labeling dimensions is a simple 
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procedure of giving a dimension a name. You can then create the different family sizes by 
creating a new type and changing the labeled dimension value.  

Figure 44. Label varying dimensions to create families with many different types.  

Families are saved as separate files. All different types that you create are stored with the 
master family file. For example, if you create a family called “double-hung window” that has 
several different-size types, they would all be saved as one file. This makes file 
management much easier, because there is only one file to track. 

To add the family to your project, you can drag it into the document window, or you can 
load it using the Load From Library, Load Family command on the File menu. Once the 
family has been loaded in the project, it is saved with the project. You do not have to carry 
the original family file along with the project. However, if you change the original family you 
need to reload the family in the project to see the updated family. 

You can create families that change with the geometry of the building. For example, if you 
have an I-beam floor joist that changes length throughout the building, you may not want 
to create a separate instance of the beam for each length. In Autodesk Revit you can create 
one beam and then use drag handles to stretch it to the desired length and actually snap it 
to a known object. If that object moves, so does the beam. 

Figure 45. Multiple beam lengths. 

In many cases you need to create families that are unique to your project, for example, an 
elaborate reception desk in an entrance. This desk may be designed to fit around certain 
components, such as walls and columns. You can create this furniture family as an in-place 
family. An in-place family is created and resides in the project it was created for. If it is 
designed and locked to existing components and these components change, the in-place 
family changes accordingly. 
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How to Get Started 
Now that you have learned a little about what Autodesk Revit can do, you may be 
wondering how you can learn more. There are many tools at your disposal. It is suggested 
that you take advantage of some of the training and support available from your Autodesk 
service provider.  

Self-paced tutorials in HTML format are available on the Help menu or from the download 
section of www.autodesk.com/revit. These self-paced exercises introduce you to the 
functionality available in Autodesk Revit. The “Getting Started Exercise” demonstrates the 
advantages of Autodesk Revit and how they can be applied to an actual design. The 
additional exercises apply more specifically to individual functionality, such as creating roofs 
and stairs. The exercises include all the building models necessary to complete the training. 

Autodesk also provides distance-learning seminars on the Web. These seminars are live 
one-hour sessions conducted by an Autodesk specialist. They feature Autodesk Revit 
demonstrations of the course content. Questions concerning the course material are 
encouraged. Exercises are provided, so you can practice what you learn in the seminar. 

A discussion database is also available for Autodesk Revit users to ask questions to the 
Autodesk Revit community or to answer others’ questions. An FAQ (Frequently Asked 
Questions) section on the www.autodesk.com/revit website provides answers to commonly 
asked questions. 

Autodesk Revit is sold through Autodesk Authorized Resellers, industry experts who offer 
consultation, training, support, and other services that help you meet your business 
objectives. Contact your local Autodesk reseller for more information about getting started 
with Autodesk Revit. To locate a reseller in your area visit www.autodesk.com/reseller. 
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